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Chapter 103

Superiority by a
Margin Tests for One
Proportion
Introduction
This module provides power analysis and sample size calculation for one-sample proportion tests in which the
researcher is testing whether the proportion is different from a hypothesized proportion by some specified
amount. Users may choose from among five popular test statistics commonly used for running the hypothesis test.
Approximate sample size formulas for tests of a single proportion are presented in Chow et al. (2008) page 85.
However, only large sample (normal approximation) results are given there. This procedure has the capability for
computing power using both the normal approximation and binomial enumeration for all tests. Some sample size
programs use only the normal approximation to the binomial distribution for power and sample size estimates.
The normal approximation is accurate for large sample sizes and for proportions between 0.2 and 0.8, roughly.
When the sample sizes are small or the proportions are extreme (i.e. less than 0.2 or greater than 0.8) the binomial
calculations are much more accurate.

Example
A superiority test example will set the stage for the discussion of the terminology that follows. Suppose that the
current treatment for a disease is effective 70% of the time. This treatment is inexpensive and exhibits few sideeffects. A promising new treatment has been developed to the point where it can be tested, but the treatment is
more expensive and may have more side-effects. One of the basic questions that must be answered is whether the
new treatment is effective enough to justify its use over the treatment with the known effectiveness of 70%. In
other words, do more than 70% of treated subjects respond to the new treatment?
After thoughtful discussion with several clinicians, it was decided that if a response of at least 78% was achieved,
the new treatment would be adopted. The difference between these two percentages may be called the margin of
superiority. The margin of superiority in this example is 8%.
The developers must design an experiment to test the hypothesis that the response rate of the new treatment is at
least 0.78. The statistical hypothesis to be tested is

H 0 : P ≤ 0.78 versus H 1 : P > 0.78
Notice that when the null hypothesis is rejected, the conclusion is that the response rate is at least 0.78. Note that
even though the response rate of the current treatment is 0.70, the hypothesis test is about a response rate of 0.78.
Also notice that a rejection of the null hypothesis results in the conclusion of interest.
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Binomial Model
A binomial variable should exhibit the following four properties:
1. The variable is binary --- it can take on one of two possible values.
2. The variable is observed a known number of times. Each observation or replication is called a Bernoulli trial.
The number of replications is n. The number of times that the outcome of interest is observed is r. Thus r
takes on the possible values 0, 1, 2, ..., n.
3. The probability, P, that the outcome of interest occurs is constant for each trial.
4. The trials are independent. The outcome of one trial does not influence the outcome of the any other trial.
A binomial probability is calculated using the formula

 n
n−r
b(r; n, P) =   Pr (1 − P)
 r
where

 n
n!
 =
 r  r !( n − r )!

The Hypergeometric Model
When samples are taken without replacement from a population of known size, N, the hypergeometric distribution
should be used in place of the binomial distribution. The properties of a variable that is distributed according to the
hypergeometric distribution are
1. The variable is binary--it can take on one of two possible values.
2. The variable is observed a known number of times. Each observation or replication is called a Bernoulli trial.
The number of replications is n. The number of times that the outcome of interest is observed is r. Thus r
takes on the possible values 0, 1, 2, ..., n.
3. The total number of items is N. The proportion of items with the characteristic of interest is P.
The hypergeometric probability of obtaining exactly r of n items with the characteristic of interest is calculated
using

 NP  N − NP
 

 r  n − r 
h(r; N , n, P) =
 N
 
 n
Note that the quantity NP is rounded to the nearest integer.
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Hypothesis Testing
Parameterizations of the Proportions
In the discussion that follows, let P represent the proportion responding as a success. That is, P is the actual
probability of a success in a binomial experiment. Let PB represent the baseline proportion. In a superiority
experiment, the baseline proportion is the response rate of the current treatment. The power of a test is computed
at a specific value of the proportion. Let P1 represent the proportion at which the power is computed.
P0 represents the smallest value of P that still results in the conclusion that the new treatment is superior to the
current treatment. The statistical hypotheses that are tested are

H 0 : P ≤ P 0 versus H 1 : P > P0
or equivalently

H 0 : P − PB ≤ d 0 versus H 1 : P − PB > d 0
where d0 is the equal to P0 – PB.
There are three common methods of specifying the margin of superiority. The most direct is to simply assign
values for PB and P0. However, it is often more meaningful to identify PB and then specify P0 implicitly by
giving their difference, ratio, or odds ratio. Mathematically, the definitions of these parameterizations are

Parameter

Computation

Hypotheses

Difference

d 0 = P0 − PB

H 0: P ≤ PB + d 0 vs H1: P > PB + d 0

Ratio

r 0 = P 0 / PB

H 0: P ≤ r 0 ( PB) vs H1: P > r 0 ( PB)

Odds Ratio

o0 = Odds 0 / OddsB

H 0 : P ≤ A vs H 1 : P > A

where A =

(o0)(PB ) .
1 − PB + (o0)(PB )

Difference
The difference is perhaps the most direct method of comparison between two proportions. It is easy to interpret
and communicate. It gives the absolute impact of the treatment. However, there are subtle difficulties that can
arise with its interpretation.
One difficulty arises when the event of interest is rare. If a difference of 0.001 occurs when the baseline
probability is 0.40, it would be dismissed as being trivial. That is, there is usually little interest in a treatment that
only decreases the probability from 0.400 to 0.399. However, if the baseline probability of a disease is 0.002, a
0.001 decrease would represent a reduction of 50%. Thus, interpretation of the difference depends on the baseline
probability of the event. As a rule of thumb, the difference is best suited for those cases in which 0.20 < P < 0.80.

Superiority using a Difference
The following example is intended to help you understand the concept of superiority. Suppose 60% of patients
respond to the current treatment method (PB = 0.60). If the response rate of the new treatment is at least ten
percentage points better (d0 = 0.10), it will be considered to be superior to the existing treatment. Substituting
these figures into the statistical hypotheses gives H 0: d ≤ 010
. . The relationship P0 = PB +
. versus H1: d > 010
d0 gives H 0: P ≤ 0.70 versus H1: P > 0.70 .
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In this example, when the null hypothesis is rejected, the concluded alternative is that the response rate is at least
0.70. That is, the conclusion of superiority is that the new treatment’s response rate is at least 0.10 more than that
of the existing treatment.

Ratio
The ratio r0 = PS / PB gives the relative change in the probability of the response. Testing non-zero null
hypotheses use the same formulation H 0: r ≤ r 0 versus H1: r > r 0 .

Superiority using a Ratio
The following example is intended to help you understand the concept of superiority as it applies to the ratio.
Suppose that 60% of patients (PB = 0.60) respond to the current treatment method. If a new treatment increases
the response rate by at least 10% (r0 = 1.10), it will be considered to be superior to the existing treatment.
Substituting these figures into the statistical hypotheses gives H 0: r ≤ 110
. . The relationship
. versus H1: r > 110
P0 = (r0)(PB) gives H 0: P ≤ 0.66 versus H1: P > 0.66 .
In this example, when the null hypothesis is rejected, the concluded alternative is that the response rate is at least
66%. That is, the conclusion of superiority is that the new treatment’s response rate is at least 10% more than that
of the existing treatment.

Odds Ratio
The odds ratio, o0 = (P0 / (1 – P0)) / (PB / (1 – PB)), gives the relative change in the odds of the response. Testing
superiority hypotheses uses the similar formulation H 0: o ≤ o0 versus H1: o > o0 .

Test Statistics
Many different test statistics have been proposed for non-inferiority tests of a single proportion. Most of these were
proposed before computers or hand calculators were widely available. Although these legacy methods are still
presented in textbooks, their power and accuracy should be compared against modern exact methods before they are
adopted for serious research. To make this comparison easy, the power and significance of several tests of a single
proportion are available in this procedure.

Exact Test
The test statistic is r, the number of successes in n trials. This test should be the standard against which other test
statistics are judged. The significance level and power are computed by enumerating the possible values of r,
computing the probability of each value, and then computing the corresponding value of the test statistic. Hence
the values that are reported in the output for these tests are exact, not approximate.

Z-Tests
Several z statistics have been proposed that use the central limit theorem. This theorem states that for large sample
sizes, the distribution of the z statistic is approximately normal. All of these tests take the following form:

z=

p − PB − d 0 p − P0
=
s
s

Although these z tests were developed because the distribution of z is approximately normal in large samples, the
actual significance level and power can be computed exactly using the binomial distribution.
We include four z tests which are based on two methods for computing s and whether a continuity correction is
applied.
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Z-Test using S(P0)
This test statistic uses the value of P0 to compute s.

z1 =

p − PB − d 0
=
(PB + d 0)(1 − (PB + d 0)) / n

p − P0
P0(1 − P0) / n

Z-Test using S(P0) with Continuity Correction
This test statistic is similar to the one above except that a continuity correction is applied to make the normal
distribution more closely approximate the binomial distribution.

z2 =

( p − PB − d 0) + c
(PB + d 0)(1 − (PB + d 0)) / n

=

( p − P0) + c
P 0(1 − P 0) / n

where

−1
if p > P0
 2n
 1
c=
if p < P0
 2n
 0 if p − P0 < 1

2n
Z-Test using S(Phat)
This test statistic uses the value of p to compute s.

z3 =

p − PB − d 0
=
p (1 − p ) / n

p − P0
p (1 − p ) / n

Z-Test using S(Phat) with Continuity Correction
This test statistic is similar to the one above except that a continuity correction is applied to make the normal
distribution more closely approximate the binomial distribution.

z4 =

( p − PB − d 0) + c = ( p − P0) + c
p (1 − p ) / n
p (1 − p ) / n

where

−1
if p > P0
 2n
 1
c=
if p < P0
 2n
 0 if p − P0 < 1

2n
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Power Calculation
Normal Approximation Method
Power may be calculated for one-sample proportions superiority tests using the normal approximation to the binomial
distribution. This section provides the power calculation formulas for the various test statistics available in this
procedure. In each case, power is presented for the lower and upper one-sided hypothesis tests. In the equations that
follow, Φ() represents the standard normal cumulative distribution function, and 𝑧𝑧𝛼𝛼 represents the value that leaves α
in the upper tail of the standard normal distribution. All power values are evaluated at 𝑃𝑃 = 𝑃𝑃1.

Exact Test

Power for the higher proportions worse hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≥ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 < 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃ET,

Lower One−Sided

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) − 𝑧𝑧𝛼𝛼 �𝑃𝑃0(1 − 𝑃𝑃0)𝐹𝐹𝐹𝐹𝐹𝐹

= Φ�

�𝑃𝑃1(1 − 𝑃𝑃1)𝐹𝐹𝐹𝐹𝐹𝐹

�

where 𝐹𝐹𝐹𝐹𝐹𝐹 = (𝑁𝑁 − 𝑛𝑛)⁄(𝑁𝑁 − 1) if the population size, N, is finite, and 𝐹𝐹𝐹𝐹𝐹𝐹 = 1 if the population size is infinite.

Power for the higher proportions better hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≤ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 > 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃ET,

Upper One−Sided

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) + 𝑧𝑧𝛼𝛼 �𝑃𝑃0(1 − 𝑃𝑃0)𝐹𝐹𝐹𝐹𝐹𝐹

= 1 − Φ�

�𝑃𝑃1(1 − 𝑃𝑃1)𝐹𝐹𝐹𝐹𝐹𝐹

Z Test using S(P0)

�

Power for the higher proportions worse hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≥ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 < 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑍𝑍𝑍𝑍(𝑃𝑃0),

𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) − 𝑧𝑧𝛼𝛼 �𝑃𝑃0(1 − 𝑃𝑃0)
�
�𝑃𝑃1(1 − 𝑃𝑃1)

= Φ�

Power for the higher proportions better hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≤ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 > 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑍𝑍𝑍𝑍(𝑃𝑃0),

𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) + 𝑧𝑧𝛼𝛼 �𝑃𝑃0(1 − 𝑃𝑃0)
�
�𝑃𝑃1(1 − 𝑃𝑃1)

= 1 − Φ�

Z Test using S(P0) with Continuity Correction

Power for the higher proportions worse hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≥ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 < 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑍𝑍𝑍𝑍(𝑃𝑃0)𝐶𝐶𝐶𝐶,

𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) − 𝑧𝑧𝛼𝛼 �𝑃𝑃0(1 − 𝑃𝑃0) − 𝑐𝑐

= Φ�

�𝑃𝑃1(1 − 𝑃𝑃1)

Power for the higher proportions better hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≤ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 > 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑍𝑍𝑍𝑍(𝑃𝑃0)𝐶𝐶𝐶𝐶,

𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

�

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) + 𝑧𝑧𝛼𝛼 �𝑃𝑃0(1 − 𝑃𝑃0) + 𝑐𝑐

= 1 − Φ�

where 𝑐𝑐 = 1⁄2√𝑛𝑛 if |𝑃𝑃1 − 𝑃𝑃0| < 1⁄2𝑛𝑛 otherwise 𝑐𝑐 = 0.

�𝑃𝑃1(1 − 𝑃𝑃1)

�
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Z Test using S(Phat)
Power for the higher proportions worse hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≥ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 < 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑒𝑒𝑟𝑟𝑍𝑍𝑍𝑍(𝑃𝑃1),

𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) − 𝑧𝑧𝛼𝛼 �𝑃𝑃1(1 − 𝑃𝑃1)
�
�𝑃𝑃1(1 − 𝑃𝑃1)

= Φ�

Power for the higher proportions better hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≤ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 > 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑍𝑍𝑍𝑍(𝑃𝑃1),

𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) + 𝑧𝑧𝛼𝛼 �𝑃𝑃1(1 − 𝑃𝑃1)
�
�𝑃𝑃1(1 − 𝑃𝑃1)

= 1 − Φ�

Z Test using S(Phat) with Continuity Correction

Power for the higher proportions worse hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≥ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 < 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑍𝑍𝑍𝑍(𝑃𝑃1)𝐶𝐶𝐶𝐶,

𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) − 𝑧𝑧𝛼𝛼 �𝑃𝑃1(1 − 𝑃𝑃1) − 𝑐𝑐

= Φ�

�𝑃𝑃1(1 − 𝑃𝑃1)

Power for the higher proportions better hypothesis test of 𝐻𝐻0: 𝑃𝑃 ≤ 𝑃𝑃0 vs. 𝐻𝐻1: 𝑃𝑃 > 𝑃𝑃0 is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑍𝑍𝑍𝑍(𝑃𝑃1)𝐶𝐶𝐶𝐶,

𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 𝑂𝑂𝑂𝑂𝑂𝑂−𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

�

√𝑛𝑛(𝑃𝑃0 − 𝑃𝑃1) + 𝑧𝑧𝛼𝛼 �𝑃𝑃1(1 − 𝑃𝑃1) + 𝑐𝑐

= 1 − Φ�

where 𝑐𝑐 = 1⁄2√𝑛𝑛 if |𝑃𝑃1 − 𝑃𝑃0| < 1⁄2𝑛𝑛 otherwise 𝑐𝑐 = 0.

�𝑃𝑃1(1 − 𝑃𝑃1)

�

Steps to Calculate Power using Binomial Enumeration of All Possible
Outcomes
Historically, power and sample size calculations for a one-sample proportion test have been based on normal
approximations to the binomial. However, with the speed of modern computers using the normal approximation is
unnecessary, especially for small samples. Rather, the significance level and power can be computed using
complete enumeration of all possible values of x, the number of successes in a sample of size n.
This is done as follows.
1. The critical value of the test is computed using standard techniques.
2. For each possible value of x, the value of the test statistic (z-test or exact test) is computed along with its
associated probability of occurrence.
3. The significance level and power are computed by summing the probabilities of occurrence for all values
of the test statistic that are greater than (or less than) the critical value. Each probability of occurrence is
calculated using P0 for the significance level and P1 for the power.
Other variables such as the sample size are then found using an efficient search algorithm. Although this method
is not as elegant as a closed-form solution, it is completely accurate.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are Power, Sample Size, and Effect Size.

Power Calculation
Power Calculation Method
Select the method to be used to calculate power. When the sample sizes are reasonably large (i.e. greater than 50)
and the proportions are between 0.2 and 0.8 the two methods will give similar results. For smaller sample sizes
and more extreme proportions (less than 0.2 or greater than 0.8), the normal approximation is not as accurate so
the binomial calculations may be more appropriate.
The choices are
•

Binomial Enumeration
Power for each test is computed using binomial enumeration of all possible outcomes when n ≤ Max n for
Binomial Enumeration (otherwise, the normal approximation is used). Binomial enumeration of all outcomes
is possible because of the discrete nature of the data.

•

Normal Approximation
Approximate power for each test is computed using the normal approximation to the binomial distribution.

Actual alpha values are only computed when “Binomial Enumeration” is selected.
Max n for Binomial Enumeration
Only shown when Power Calculation Method = “Binomial Enumeration”
When n is less than or equal to this value, power is calculated using the binomial distribution and enumeration of
all possible outcomes. This is possible because of the discrete nature of the data. “Actual Alpha” values are only
computed when binomial power calculations are made.
When n is greater than this value, the normal approximation to the binomial is used when calculating power.
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Test
Higher Proportions Are
This option specifies whether proportions represent successes or failures.
•

Better
When proportions represent successes, the higher proportions are better. In this case, a superior treatment is
one whose proportion is higher than the baseline. The alternative hypothesis of superiority is H1: P > P0,
where P0 is greater than PB.

•

Worse
When proportions represent failures, the lower proportions are better. In this case, a superior treatment is one
whose proportion is lower than the baseline. The alternative hypothesis of superiority is H1: P < P0, where P0
is lower than PB.

Test Type
Specify the type of test that will be used in reporting. Note that C.C. is short for Continuity Correction. This refers
to the adding or subtracting 1/(2n) to (or from) the numerator of the z-value to bring the normal approximation
closer to the binomial distribution.
N (Population Size)
Only shown when Test Type = “Exact Test”
Enter the total number of items in the population from which the sample of n items is selected. Enter Infinite to
signify an infinite population so that no correction factor is applied. An infinite population is generally one in
which the number in the population is large and unknown.
Note that N must be greater than n.
When samples are drawn from a very large (infinite) population, calculations are based on the binomial
distribution.
When samples are drawn from a population of known size, specified here as N, calculations are based on the
hypergeometric distribution.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
Note that because of the discrete nature of the binomial distribution, the alpha level rarely will be achieved
exactly.
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A single value may be entered here or a range of values such as 0.05 to 0.2 by 0.05 may be entered.

Sample Size
n (Sample Size)
Enter a value (or range of values) for the sample size n. This is the number of individuals sampled in the study.
Values must be integers greater than one.
You may a single value or a range of values such as 10, 50, 100 or 10 to 100 by 10.

Effect Size
Input Type
Indicate what type of values to enter to specify the superiority margin and effect size. Regardless of the entry type
chosen, the test statistics used in the power and sample size calculations are the same. This option is simply given
for convenience in specifying the superiority margin and effect size.
PB (Baseline Proportion)
Enter a value (or range of values) for the baseline proportion. In a superiority study, this is the response rate of the
standard (existing) treatment. Note that this is not the value of P0. Instead, this value is used in the calculation of
P0.
Proportions must be between zero and one.
You may enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.
P0 (Superiority Proportion)
Enter the value of the proportion that is the superiority cutoff.
If Higher Proportions are "Better", proportions higher than this proportion are considered superior. If Higher
Proportions are "Worse", proportions lower than this proportion are considered superior.
The reference proportion (PB) is not needed for calculation of power using this module.
Since this value is a proportion, it must be a positive value less than one.
P1 (Actual Proportion)
This is the value of the proportion (P1) at which the power calculations are made.
If Higher Proportions are "Better", P1 should be larger than P0. If Higher Proportions are "Worse", P1 should be
less than P0.
Proportions must be between zero and one.
You may enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.
d0 (Superiority Difference)
Enter the difference from PB (Baseline Proportion) that defines the superiority cutoff.
The resulting superiority cut-off is P0 = PB + d0.
If Higher Proportions are "Better", d0 should be positive. If Higher Proportions are "Worse", d0 should be
negative.
PB + d0 must be between 0 and 1.
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d1 (Actual Difference)
This option specifies the value of P1 (the actual proportion) by specifying the difference between the two
proportions P1 and PB. This difference is used with PB to calculate the value of P1 using the formula: P1 = PB +
d1.
The power calculations assume that P1 is the actual value of the proportion.
If Higher Proportions are "Better", d1 should be positive and greater than d0. If Higher Proportions are "Worse",
d1 should be negative and less than d0.
Differences must be between -1 and 1.
You may enter a range of values such as .03 .05 .10 or .01 to .05 by .01.
r0 (Superiority Ratio)
Enter the ratio of P0 to PB (Baseline Proportion) that defines the superiority cutoff.
The resulting superiority cut-off is P0 = PB * r0.
If Higher Proportions are "Better", r0 should be greater than one. If Higher Proportions are "Worse", r0 should be
less than one.
PB * r0 must be between 0 and 1.
r1 (Actual Ratio)
This option specifies the value of P1 (the actual proportion) by specifying the ratio of P1 to PB. This ratio is used
with PB to calculate the value of P1 using the formula: P1 = PB*r1.
The power calculations assume that P1 is the actual value of the proportion.
If Higher Proportions are "Better", r1 should be greater than r0. If Higher Proportions are "Worse", r1 should be
less than r0.
Ratios must greater than zero. Note that the ratios must be small enough so that P1 is less than one.
You may enter a range of values such as .5 .6 .7 .8 or 1.25 to 2.0 by .25.
o0 (Superiority Odds Ratio)
Enter the odds ratio of P0 to PB (Baseline Proportion) that defines the superiority cutoff.
o0 = [P0(1-P0)]/[PB(1-PB)]
If Higher Proportions are "Better", o0 should be greater than one. If Higher Proportions are "Worse", o0 should be
less than one.
o0 must be such that P0 is between 0 and 1.
o1 (Actual Odds Ratio)
This option specifies the value of P1 (the actual proportion) by specifying the odds ratio of P1 to PB. This ratio is
used with PB to calculate the value of P1 using the formula:
o1 = [P1(1-P1)]/[PB(1-PB)]
The power calculations assume that P1 is the actual value of the proportion.
If Higher Proportions are "Better", o1 should be greater than o0. If Higher Proportions are "Worse", o1 should be
less than o0.
You may enter a range of values such as ".03 .05 .10" or ".01 to .05 by .01"
o1 must be such that P1 is between 0 and 1.
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Example 1 – Finding the Power
Suppose 50% of patients with a certain type of cancer survive two years using the current treatment. The current
treatment is inexpensive and has few severe side effects. A new treatment has more side effects and is more
expensive. A superiority trial is to be conducted to show that the two-year survival rate of the new treatment is
better than the current treatment. After serious consideration, the margin of superiority is set at 5%. What power
will be achieved by sample sizes of 50, 100, 200, 300, 500, or 800 and a significance level of 0.05? For
comparative purposes, also calculate the power for a margin of superiority of 10%. Assume that the true survival
rate of the new treatment is 62%.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for One Proportion procedure window by expanding
Proportions, then One Proportion, then Superiority by a Margin, and then clicking on Superiority by a
Margin Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example
1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Normal Approximation
Higher Proportions Are ........................... Better
Test Type ................................................ Z-test using S(P0)
Alpha ....................................................... 0.05
n (Sample Size) ...................................... 50 100 200 300 500 800
Input Type ............................................... Differences
PB (Baseline Proportion) ........................ 0.50
d0 (Superiority Difference) ...................... 0.05 0.10
d1 (Actual Difference) ............................. 0.12

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Z-Test with S(P0)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.25266
0.08553
0.40372
0.10600
0.63819
0.14065
0.79160
0.17196
0.93808
0.23002
0.99165
0.31040

n
50
50
100
100
200
200
300
300
500
500
800
800

Baseline
Proportion
PB
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000

Superiority
Difference
d0
0.0500
0.1000
0.0500
0.1000
0.0500
0.1000
0.0500
0.1000
0.0500
0.1000
0.0500
0.1000

Actual
Difference
d1
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200

Alpha
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500

Reject H0
If Z >
1.6449
1.6449
1.6449
1.6449
1.6449
1.6449
1.6449
1.6449
1.6449
1.6449
1.6449
1.6449
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* Power was computed using the normal approximation method.
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Report Definitions
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
n is the size of the sample drawn from the population. To conserve resources, it should be as small as
possible.
PB is the baseline or standard value of the proportion.
d0 = P0-PB is the distance above PB that is considered superior.
d1 = P1-PB is the value of the difference at which the power is calculated.
Alpha (significance level) is the probability of rejecting the null hypothesis when it is true. It should be
small.
Reject H0 If... gives the critical value(s) for the test.
Summary Statements
A sample size of 50 achieves 25.266% power to detect a superiority difference (P0-PB) of 0.0500
using a one-sided Z-test that uses S(P0) to estimate the standard deviation with a significance
level (alpha) of 0.0500. These results assume a baseline proportion (PB) of 0.5000 and that the
actual difference (P1-PB) is 0.1200.

This report shows the values of each of the parameters, one scenario per row. The values from this table are
plotted in the chart below.

Chart Section
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These plots show the relationship between power, sample size, and the minimum difference.
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Example 2 – Finding the Sample Size
Continuing from Example 1, suppose you want to find the exact sample size necessary to achieve 90% power
when the superiority difference is 0.05.
In this example we’ll show you how to setup the calculation by inputting proportions, differences, ratios, and odds
ratios. In all cases, you’ll see that the sample sizes are exactly the same. The only difference is in the way the noninferiority margin and effect size are specified.

Setup (Proportions)
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for One Proportion procedure window by expanding
Proportions, then One Proportion, then Superiority by a Margin, and then clicking on Superiority by a
Margin Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example
2a by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power Calculation Method ...................... Normal Approximation
Higher Proportions Are ........................... Better
Test Type ................................................ Z-test using S(P0)
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Input Type ............................................... Proportions
P0 (Superiority Proportion) ..................... 0.45
P1 (Actual Proportion) ............................ 0.62

Output (Proportions)
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Z-Test with S(P0)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.90037

n
424

Superiority
Proportion
P0
0.5500

Actual
Proportion
P1
0.6200

Alpha
0.0500

Reject H0
If Z >
1.6449

* Power was computed using the normal approximation method.

This report shows that a sample size of 424 will be necessary to achieve the design requirements.
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Setup (Differences)
To input P0 = 0.55 and P1=0.62 using differences, recall the relationships between P0, P1, PB, d0 and d1:
d0 = P0 – PB = 0.55 – 0.5 = 0.05
d1 = P1 – PB = 0.62 – 0.5 = 0.12
The setup for differences is exactly the same as that for proportions except for the following inputs on the Design
tab. You may then make the appropriate entries as listed below, or open Example 2b by going to the File menu
and choosing Open Example Template.
Option

Value

Design Tab
Input Type ............................................... Differences
PB (Baseline Proportion) ........................ 0.50
d0 (Superiority Difference) ...................... 0.05
d1 (Actual Difference) ............................. 0.12

Output (Differences)
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Z-Test with S(P0)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.90037

n
424

Baseline
Proportion
PB
0.5000

Superiority
Difference
d0
0.0500

Actual
Difference
d1
0.1200

Alpha
0.0500

Reject H0
If Z >
1.6449

* Power was computed using the normal approximation method.

This report shows the same sample size when the difference d0 = 0.05 is entered as the superiority difference and
d1 = 0.12 is entered as the actual difference.

Setup (Ratios)
To input P0 = 0.55 and P1=0.62 using ratios, recall the relationships between P0, P1, PB, r0 and r1:
r0 = P0/PB = 0.55/0.5 = 1.1
r1 = P1/PB = 0.62/0.5 = 1.24
The setup for ratios is exactly the same as that for proportions except for the following inputs on the Design tab.
You may then make the appropriate entries as listed below, or open Example 2c by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Input Type ............................................... Ratios
PB (Baseline Proportion) ........................ 0.50
r0 (Superiority Ratio)............................... 1.1
r1 (Actual Ratio) ...................................... 1.24
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Output (Ratios)
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Z-Test with S(P0)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.90037

n
424

Baseline
Proportion
PB
0.5000

Superiority
Ratio
r0
1.1000

Actual
Ratio
r1
1.2400

Alpha
0.0500

Reject H0
If Z >
1.6449

* Power was computed using the normal approximation method.

This report shows the same sample size when the ratio r0 = 1.1 is entered as the superiority ratio and r1 = 1.24 is
entered as the actual ratio.

Setup (Odds Ratios)
To input P0 = 0.55 and P1=0.62 using odds ratios, recall the relationships between P0, P1, PB, o0 and o1:
o0 = odds0/oddsB = [0.55/(1-0.55)] / [0.5/(1-0.5)] = 1.222222222
o1 = odds1/oddsB = [0.62/(1-0.62)] / [0.5/(1-0.5)] = 1.631578947
The setup for odds ratios is exactly the same as that for proportions except for the following inputs on the Design
tab. You may then make the appropriate entries as listed below, or open Example 2d by going to the File menu
and choosing Open Example Template.
Option

Value

Design Tab
Input Type ............................................... Odds Ratios
PB (Baseline Proportion) ........................ 0.50
o0 (Superiority Odds Ratio) .................... 1.222222222
o1 (Actual Odds Ratio) ........................... 1.631578947

Output (Odds Ratios)
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Z-Test with S(P0)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.90037

n
424

Baseline
Proportion
PB
0.5000

Superiority
Odds Ratio
o0
1.2222

Actual
Odds Ratio
o1
1.6316

Alpha
0.0500

Reject H0
If Z >
1.6449

* Power was computed using the normal approximation method.

This report shows the same sample size when the ratio o0 = 1.222222222 is entered as the superiority odds ratio
and o1 = 1.631578947 is entered as the actual odds ratio.
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Example 3 – Comparing Test Statistics
One important decision that must be made before conducting the experiment is to decide which of the available
test statistics to use. This procedure makes it easy to make this comparison. The differences in the characteristics
of test statistics are most noticeable in small samples. Hence, the investigation done here is for sample sizes of 20
to 200 in steps of 20. The trivial difference will be set to 0.05. We’ll calculate exact power using binomial
enumeration when the baseline proportion (PB) is 0.5, the actual difference (d1) is 0.12, and alpha = 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for One Proportion procedure window by expanding
Proportions, then One Proportion, then Superiority by a Margin, and then clicking on Superiority by a
Margin Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example
3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Binomial Enumeration
Max n for Binomial Enumeration ............ 10000
Higher Proportions Are ........................... Better
Test Type ................................................ Z-test using S(P0)
Alpha ....................................................... 0.05
n (Sample Size) ...................................... 20 to 200 by 20
Input Type ............................................... Differences
PB (Baseline Proportion) ........................ 0.50
d0 (Superiority Difference) ...................... 0.05
d1 (Actual Difference) ............................. 0.12
Reports Tab
Show Comparative Reports .................... Checked
Comparative Plots Tab
Show Comparative Plots ........................ Checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Power Comparison of Five Different Superiority Tests for One Proportion
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)
Baseline
Prop.
n
PB
20
0.5000
40
0.5000
60
0.5000
80
0.5000
100
0.5000
120
0.5000
140
0.5000

Super.
Diff.
d0
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500

Actual
Diff.
d1
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200

Target
Alpha
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500

Exact
Test
Power
0.07261
0.19049
0.27278
0.33369
0.38160
0.42094
0.45425

Z-Test
S(P0)
Power
0.16707
0.19049
0.27278
0.33369
0.38160
0.49551
0.52359

Z-Test
S(P0)C
Power
0.07261
0.19049
0.27278
0.33369
0.38160
0.42094
0.45425

Z-Test
S(P)
Power
0.16707
0.29333
0.27278
0.33369
0.46227
0.49551
0.52359

Z-Test
S(P)C
Power
0.16707
0.19049
0.27278
0.33369
0.38160
0.42094
0.52359
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160
180
200

0.5000
0.5000
0.5000

0.0500
0.0500
0.0500

0.1200
0.1200
0.1200

0.0500 0.54792 0.54792 0.54792 0.54792 0.54792
0.0500 0.56939 0.62849 0.56939 0.62849 0.56939
0.0500 0.58862 0.64398 0.58862 0.64398 0.64398

Note: Power was computed using binomial enumeration of all possible outcomes.
Actual Alpha Comparison of Five Different Superiority Tests for One Proportion
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

n
20
40
60
80
100
120
140
160
180
200

Baseline
Prop.
PB
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000

Super.
Diff.
d0
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500

Actual
Diff.
d1
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200

Target
Alpha
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500

Exact
Test
Alpha
0.0189
0.0386
0.0446
0.0449
0.0429
0.0399
0.0365
0.0470
0.0419
0.0373

Z-Test
S(P0)
Alpha
0.0553
0.0386
0.0446
0.0449
0.0429
0.0587
0.0526
0.0470
0.0573
0.0505

Z-Test
S(P0)C
Alpha
0.0189
0.0386
0.0446
0.0449
0.0429
0.0399
0.0365
0.0470
0.0419
0.0373

Z-Test
S(P)
Alpha
0.0553
0.0751
0.0446
0.0449
0.0651
0.0587
0.0526
0.0470
0.0573
0.0505

Z-Test
S(P)C
Alpha
0.0553
0.0386
0.0446
0.0449
0.0429
0.0399
0.0526
0.0470
0.0419
0.0505

Note: Actual alpha was computed using binomial enumeration of all possible outcomes.
Chart Section

The first numeric report shows the power for each test statistic. The second shows the actual alpha achieved by
the design.
An examination of the first report shows that the power is often different for at least one of the tests. Also notice
that the exact test always has the minimum power in each row. This would lead us discard this test statistic.
However, consider the second report which shows the actual alpha level (the target was 0.05) for each test. By
inspecting corresponding entries in both tables, we see that whenever a test statistic achieves a better power than
the exact test, it also yields an actual alpha level larger than the target alpha.
For example, look at the powers for n = 20. The z-test using s(phat) has an unusually large power = 0.16707. This
is a much larger power than the exact test’s value of 0.07261. However, note that the actual alpha for this test is
0.0553 which is larger than the target alpha of 0.05.
We conclude that indeed, the exact test is consistently the best test since it always achieves a significance level
that is less than the target value.
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Example 4 – Comparing Power Calculation Methods
Continuing with Example 3, let’s see how the results compare if we were to use approximate power calculations
instead of power calculations based on binomial enumeration.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for One Proportion procedure window by expanding
Proportions, then One Proportion, then Superiority by a Margin, and then clicking on Superiority by a
Margin Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example
4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Binomial Enumeration
Max n for Binomial Enumeration ............ 10000
Higher Proportions Are ........................... Better
Test Type ................................................ Z-test using S(P0)
Alpha ....................................................... 0.05
n (Sample Size) ...................................... 20 to 200 by 20
Input Type ............................................... Differences
PB (Baseline Proportion) ........................ 0.50
d0 (Superiority Difference) ...................... 0.05
d1 (Actual Difference) ............................. 0.12
Reports Tab
Show Power Detail Report ..................... Checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Power Detail Report for Testing Superiority of One Proportion using the Z-Test with S(P0)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)
n
20
40
60
80
100
120
140
160
180
200

PB
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000

d0
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500

d1
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200
0.1200

Normal Approximation
Power
Alpha
0.14895
0.0500
0.21953
0.0500
0.28475
0.0500
0.34606
0.0500
0.40372
0.0500
0.45776
0.0500
0.50817
0.0500
0.55500
0.0500
0.59831
0.0500
0.63819
0.0500

Binomial Enumeration
Power
Alpha
0.16707
0.0553
0.19049
0.0386
0.27278
0.0446
0.33369
0.0449
0.38160
0.0429
0.49551
0.0587
0.52359
0.0526
0.54792
0.0470
0.62849
0.0573
0.64398
0.0505

Notice that the power values are pretty consistent for both methods. For some sample sizes, however, the actual
alpha level computed using binomial enumeration is greater than the target of 0.05.
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Example 5 – Finding Power after an Experiment
The proportion of successes of the current treatment is known to be 0.64 based on years of treatment use.
Researchers have developed a new method of treatment which costs much more than the current treatment price.
Before the new treatment can be approved it must be shown that the success of the proposed treatment is superior
to that of the current treatment. It is determined that use of the new treatment is justifiable if it is shown that it is
effective more than 74% of the time. Sixty individuals are randomly selected to receive the new method of
treatment. Forty-six (76.67%) of the 60 individuals responded positively to the treatment. The p-value for the test
based on exact binomial probabilities is 0.3814. Because the researchers were unable to show the new treatment is
superior, they desire to know the power of the test if the actual difference is 0.13.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for One Proportion procedure window by expanding
Proportions, then One Proportion, then Superiority by a Margin, and then clicking on Superiority by a
Margin Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example
5 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Binomial Enumeration
Max n for Binomial Enumeration ............ 10000
Higher Proportions Are ........................... Better
Test Type ................................................ Exact Test
N (Population Size) ................................. Infinite
Alpha ....................................................... 0.05
n (Sample Size) ...................................... 60
Input Type ............................................... Differences
PB (Baseline Proportion) ........................ 0.64
d0 (Superiority Difference) ...................... 0.10
d1 (Actual Difference) ............................. 0.13

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Exact Test
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.08932

n
60

Baseline
Proportion
PB
0.6400

Superiority
Difference
d0
0.1000

Actual
Difference
d1
0.1300

Target
Alpha
0.0500

Actual
Alpha*
0.0312

Reject H0
If R ≥
51

* Power and actual alpha were computed using binomial enumeration of all possible outcomes.

This report shows that the power for the test was only 0.08932.
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Example 6 – Finding Sample Size based on the Odds Ratio
The odds for success of the current treatment is known be 3.87. A new treatment is developed to compete with the
current treatment. It must be shown to be superior to the current treatment to be adopted. The researchers want to
determine the sample size necessary to achieve 80% power in this test of superiority. The researchers determine
that the new treatment will be considered superior if the odds for success are greater than 1.2 times the odds for
success of the current treatment. The baseline proportion is calculated as PB = odds/(1+odds) = 3.87/(1+3.87) =
0.7947. They want to calculate sample sizes for actual odds ratios between 1.3 and 1.5.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for One Proportion procedure window by expanding
Proportions, then One Proportion, then Superiority by a Margin, and then clicking on Superiority by a
Margin Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example
6 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power Calculation Method ...................... Normal Approximation
Higher Proportions Are ........................... Better
Test Type ................................................ Z-test using S(P0)
N (Population Size) ................................. Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Input Type ............................................... Odds Ratios
PB (Baseline Proportion) ........................ 0.7947
o0 (Superiority Odds Ratio) .................... 1.2
o1 (Actual Odds Ratio) ........................... 1.3 1.4 1.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Z-Test with S(P0)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.80005
0.80019
0.80016

n
6853
1909
939

Baseline
Proportion
PB
0.7947
0.7947
0.7947

Superiority
Odds Ratio
o0
1.2000
1.2000
1.2000

Actual
Odds Ratio
o1
1.3000
1.4000
1.5000

Alpha
0.0500
0.0500
0.0500

Reject H0
If Z >
1.6449
1.6449
1.6449

* Power was computed using the normal approximation method.

The sample size range between 6853 and 939 to show superiority under these conditions based on the actual odds
ratio.
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Example 7 – Validation using Chow, Shao, and Wang (2008)
Chow, Shao, and Wang (2008) page 87 gives the result of a sample size calculation for the z-test with S(Phat).
Although the test given there is for non-inferiority, the form of the test is the same so we can use those results to
validate the calculations of this procedure. They calculate a sample size of 18 when alpha = 0.05, power = 0.80,
PB = 0.30, non-inferiority difference = -0.10 (P0 = 0.30 – 0.10 = 0.2), and actual difference = 0.20 (such that
actual proportion = 0.50).

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for One Proportion procedure window by expanding
Proportions, then One Proportion, then Superiority by a Margin, and then clicking on Superiority by a
Margin Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example
7 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power Calculation Method ...................... Normal Approximation
Higher Proportions Are ........................... Better
Test Type ................................................ Z-test using S(Phat)
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Input Type ............................................... Proportions
P0 (Superiority Proportion) ..................... 0.2
P1 (Actual Proportion) ............................ 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Superiority of One Proportion using the Z-Test with S(Phat)
Higher Proportions are Better
Alternative Hypothesis: One-Sided (H0: P ≤ P0 vs. H1: P > P0)

Power*
0.81613

n
18

Superiority
Proportion
P0
0.2000

Actual
Proportion
P1
0.5000

Alpha
0.0500

Reject H0
If Z >
1.6449

* Power was computed using the normal approximation method.

PASS also calculated a sample size of 18.
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